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While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist. The recipient of this document is 
solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is 
subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, or translated into another language, without the prior written 
consent of Deltek, Inc. 

This edition published July 2017. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 
Unauthorized reproduction or distribution of the program or any portion thereof could result in 
severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  
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Overview 

Welcome to wInsight Analytics Module 8.1.1. This installation guide will help you successfully 
install this application on your system and make it work efficiently according to your organization’s 
business structure. 
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Downloading Deltek Products using Deltek 
Software Manager 

You can use Deltek Software Manager (DSM) to download complete Deltek products, cumulative 
updates, and sub-releases. You access DSM through the Deltek Customer Care Connect site. 

When you access DSM from within the Deltek Customer Care Connect site, you do not have to 
log on since you are already logged into the Customer Care Connect site. 

Accessing DSM from within the Customer Care Connect Site 

To access Deltek Software Manager from within the Customer Care Connect site, complete 
the following steps: 

1. In your Web browser, go to http://support.deltek.com. 

2. Enter your Customer Care Connect User name and Password, and click Log In. 

3. When the Customer Care Connect site displays, click the Product Downloads tab. 

You are automatically logged in to Deltek Software Manager. 

4. To select the folder where you want to download Deltek products, click Settings above 
the right pane of Deltek Software Manager. 

 

When you log on for the first time, Deltek Software Manager asks you to select a 
default folder where Deltek products are to be downloaded. 

5. Use the Settings dialog box to specify the folder where you want to download Deltek 
products, and click OK. 

 

You can change this folder anytime in the Settings dialog box. 

6. In the left pane of Deltek Software Manager, expand the Deltek product that you want to 
download, if it is not already expanded.  

 

If you want to download a Beta or LA version and it is not visible, click the View menu 
and select Show Beta/LA Versions. 

7. Select the product type that you want to download. Your options are Complete, 
Cumulative Update, and Sub-Release. 

8. In the table, select the check box that corresponds to the Deltek product that you want to 
download. The right pane displays a message stating that the product has been added to 
the download queue. 

 

To view the items in the download queue, click View Download Queue at the bottom 

of the left pane. 

9. Click Download at the bottom of the left pane. Deltek Software Manager downloads the 
product to the folder that you selected.  

http://support.deltek.com/
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DSM Documentation and Troubleshooting 

 To view the online help for Deltek Software Manager, click here. 

 To view a tutorial on how to use Deltek Software Manager, click here.  

 To view more information on troubleshooting Deltek Software Manager, click here. 

 

The above troubleshooting link will only work if you are logged into Deltek Customer Care 
Connect. 

https://dsm.deltek.com/DeltekSoftwareManager/Help/
https://dsm.deltek.com/DeltekSoftwareManager/Tutorial/PubData/Engine/Default.htm?https%3A%2F%2Fdsm.deltek.com%2FDeltekSoftwareManager%2FTutorial%2FPubData%2F
https://deltek.custhelp.com/app/answers/detail/a_id/52469
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Before You Begin Deployment 

Before you begin deployment, it is important to understand the following: 

 Logical Tiers 

 Installation/Deployment Models 

 Hardware and Software Requirements 

Logical Tiers Overview 

The wInsight Analytics product suite uses a multitier (n-tier) architecture. Various parts of a 
wInsight Analytics product are distributed to logical tiers for performance and scalability. The 
logical tiers are as follows: 

 Client Tier — This tier performs wInsight Analytic’s functional process logic and provides 
the user interface layer.  

 Web/Application Tier — The Web tier, which contains no business logic, passes 
requests from browser to server and vice versa, while also packaging and unpackaging 
data. The application tier, built around QlickView Server, maintains both user sessions 
and manages application transactions. 

 Database Tier — This tier consists of database servers where the wInsight Analytics 
data is stored and retrieved. 

Installation/Deployment Models 

Stand-Alone Deployment 

Deltek wInsight Analytics has a stand-alone deployment model. Users who previously operated 
the legacy wInsight Desktop or Professional interface installed on their workstations can continue 
to use the decentralized deployment model with wInsight Analytics. 
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N-Tier Deployment 

 

If the wInsight Analytics Module is deployed in a multi-tier mode, the wInsight Analytics 
Administrator and wInsight Analytics Desktop uses a client-server deployment model. 

In an n-tier installation, the processing occurs on the application server. It is recommended that 
the database tier reside on a different computer than the application server. The connection 
between the application server and the database should limit the number of routers and firewalls 
that can adversely affect data traffic. 
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Unsupported Scenarios 

The wInsight Analytics Module installation does not support installing any tiers on any of the 
following servers:  

 Domain Controller  

 Microsoft® Exchange Server  

 Proxy, Firewall, or ISA Server  

 Microsoft SharePoint Portal Server  

 Small Business/Essential Business Server  

Using these services/servers can cause significant issues in the performance, reliability, and 
functionality of the application and other applications on your network. 

System Requirements 

Your organization has made a substantial commitment to ensure it has a fully integrated earned 
value management (EVM) solution. To support that commitment, Deltek recommends that you 
carefully consider the hardware requirements necessary to run a wInsight Analytics product 
properly. 

Platform Virtualization  

Platform Virtualization is a new technology that allows multiple operating systems and 
platforms to run simultaneously as separate virtual machines on a single set of server hardware.  

Deltek recognizes the growing use of virtual environments by our customers. Virtual environment 
software, such as VMware®, resides in the hardware layer underneath the operating system and 
is used by customers to partition a single server into a multiple server/multiple operating system 
environment. Deltek’s product development makes limited use of virtual environments at this 
time.  

 

For more information, see Virtual Environments Statement on the Deltek Support Center. 

Display Settings 

The recommended display resolution is 1440 x 900 or higher. 

Hardware Sizing Considerations 

There are several factors that go into sizing an appropriate server infrastructure. The number of 
concurrent users accessing the system at any given time, the amount of data being analyzed, 
and growth expectations all have an impact on the initial sizing plans. The hardware profiles are 
intended as a starting point for deployment. It is expected that our clients will use the product in 
many different ways, such as planning for future release, and client customizations. Further in-
depth discussion of the business needs of the solution during implementations of application will 
provide final guidance on hardware requirements. 

The number of elements, records, contracts, and accounting periods analyzed all have an impact 
on the amount of RAM you will need in the application server. This data, along with other 
information, is loaded into RAM on the application server, which allows for much more rapid 
analytics and display results. If the application server does not have enough RAM to store all of 
the required data, then it will get loaded into virtual memory, which has a significantly slower 

https://deltek.custhelp.com/app/utils/login_form/redirect/home
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response capability than RAM.  All data used by wInsight Analytics for aggregation and display is 
stored in system memory, so hard drive storage does not have a significant impact on server 
sizing. 

 

For the wInsight Analytics Module, the memory of the server should be approximately 10% – 
20% of the database size (for example, 1- 2GB for a 10 GB database) plus 10% for each 
concurrent user. This would mean that for an Oracle or SQL Server where the data size is 10 
GB and where you expect 20 concurrent users, you should allow 2GB plus 20 x 200 MB, for 
example, 6 GB of memory for the wInsight Analytics Module. 

Memory Requirements for a Typical/Average Use 

Below are details on the memory footprint of the product. This can be helpful when sizing a client 
tier that runs in a virtual environment, Citrix®, or Terminal Server. 

Tier Memory* 

Client Tier 2 GB (assuming the wInsight Analytics Module is being run as a 
server application) 

Web / Application Tier N/A 

Database Tier  Database instance memory should be 10%–15% of the 
database size. For example, if database size is expected to 
be 500 GB, then allocate 50 GB–75 GB memory. 

* Per concurrent client instance and in addition to any memory needed for the operating system 
and other applications that may run in parallel with this product. 

Definition of Typical/Average Use 

Sample Details for a Typical Small/Medium Data Sizing: 

 Number of Contracts: 50 

 Number of Element Records: 50,000   

 Number of Earned Value Records: 1,200,000 

 Number of Past and Future Period Records: 75,000,000 

Hardware Requirements 

 

Specific server hardware configurations may have an impact on your overall Deltek product 
licensing requirements. It is recommended you confirm with a Deltek Technical Sales Engineer 
if the server hardware you plan to deploy is in line with your Deltek license agreement and how 
overall server infrastructure expansion in the future may affect your Deltek licensing. 

Stand-Alone Deployment 

The following table lists the recommended minimum hardware and software requirements for a 
deployment in a stand-alone environment. 

Tier Hardware Required Determining Factors 

Client Tier  Intel Core 2.0 Duo or higher Database Size 
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Tier Hardware Required Determining Factors 

 4 GB RAM (Depending on data volumes, 
more may be required.) 

 80 GB Hard Drive 

Database Growth 

N-Tier Deployment 

 

If the wInsight Analytics Module is deployed in a multi-tier mode, the wInsight Analytics 
Administrator and wInsight Analytics Desktop uses a client-server deployment model. 

N-Tier Installation for 1 to 10 Concurrent Users 

Tier Hardware Required Determining Factors 

Web/ 
Application 
Tier 

Server Class Machine 

  1 x Six-core x64 2.86+ GHz or faster CPU 

 32+ GB Physical memory (adjust as 
needed based on the RAM discussion 
below) 

 RAID 1 Disk array (for fault tolerance and 
performance, also consider adding an 
additional hard drive to perform as a hot 
spare for the RAID set) 

 100/1000 Mb Network card  

 Number of 
contracts 

 Contract size 

 Number of 
elements and 
records analyzed 

 Number of 
accounting periods 
used (# of months 
& subperiods) 

 Configuration of 
QVW 

 Concurrent Users 

N-Tier Installation for 11 to 25 Concurrent Users 

Tier Hardware Required Determining Factors 

Web/ 
Application 
Tier 

Server Class Machine 

 2 x Six-core x64 2.86+ GHz or faster CPU 

 64+ GB Physical memory (adjust as 
needed based on above RAM discussion) 

 RAID 1 Disk array (for fault tolerance and 
performance, also consider adding an 
additional hard drive to perform as a hot 
spare for the RAID set) 

 100/1000 Mb Network card  

 Number of 
contracts 

 Contract size 

 Number of 
elements and 
records analyzed 

 Number of 
accounting periods 
used (# of months 
& subperiods) 

 Configuration of 
QVW 

 Concurrent Users 
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N-Tier Installation for 26+ Concurrent Users 

Tier Hardware Required Determining Factors 

Web/ 
Application 
Tier 

Server Class Machine 

 2 x Six-core x64 2.86+ GHz or faster CPU 

 64+ GB Physical memory (adjust as 
needed based on the RAM discussion 
below) 

 RAID 1 Disk array (for fault tolerance and 
performance, also consider adding an 
additional hard drive to perform as a hot 
spare for the RAID set) 

 100/1000 Mb Network card 

 Number of 
contracts 

 Contract size 

 Number of 
elements and 
records analyzed 

 Number of 
accounting periods 
used (# of months 
& subperiods) 

 Configuration of 
QVW 

 Concurrent Users 

Software Requirements 

 

Supported versions are the currently actively tested versions of technologies used to deploy 
wInsight Analytics. Except for the Deltek Integrated Products, these technologies are not 
directly supported by Deltek. Changes to these technologies occur at the discretion of the 
individual technology vendors.  

Compatible versions are the recent previously supported and tested technologies used to 
deploy wInsight Analytics. These are not actively being tested but are believed to be 
compatible with wInsight Analytics. Deltek does not recommend these technologies for new 
deployments but will make its best effort to answer questions concerning these technologies. 
These technologies may not be available for troubleshooting at Deltek. 

For a complete list of the recommended minimum software requirements, see the Deltek 
Product Support Compatibility Matrix document that you can download from the Deltek Support 
Center. 

Stand-Alone Installation 

Supported and Compatible Deployment Technology 

Operating System  Microsoft Windows® 7 

 Microsoft Windows 8.1 

 Microsoft Windows 10 

 Microsoft  Windows Server® 2008 R2 (x64) (Compatible)   

 Microsoft  Windows Server 2012 

 Microsoft  Windows Server 2012 R2 

Citrix  XenApp® 6.0 (Windows Server 2008 R2) (Compatible)   

 XenApp 6.5 (Windows Server 2008 R2) (Compatible)   

 XenApp 7.0 (Windows Server 2008 R2) (Compatible)   

https://deltek.custhelp.com/app/utils/login_form/redirect/home
https://deltek.custhelp.com/app/utils/login_form/redirect/home
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Supported and Compatible Deployment Technology 

 XenApp 7.0 (Windows Server 2012) 

 XenApp 7.0 (Windows Server 2012 R2) 

 XenApp 7.6 (Windows Server 2012 R2) 

 XenApp 7.7 (Windows Server 2012 R2) 

 XenApp 7.8 (Windows Server 2012 R2) 

 XenApp 7.9 (Windows Server 2012 R2) 

Database  Microsoft SQL Server 2008 R2 (Compatible)   

 Microsoft SQL Server 2012 

 Microsoft SQL Server 2014 

 Microsoft SQL Server 2016 

 Microsoft Access 2007 

 Microsoft Access 2010 

 Microsoft Access 2013 

 Microsoft Access 2016 

 Oracle 11.2 

 Oracle 12.1 

  Oracle is also supported on Linux, Unix, and Exadata 

Database Drivers NOTE: wInsight Analytics Module requires 64-bit database drivers. 

 Oracle Provider for OLE DB 

 Microsoft SQL Server Native Client 

 Microsoft OLE DB Provider for SQL Server 

 Microsoft OLE DB Provider for Jet 

 Microsoft ACE OLEDB 12 

 Microsoft ACE OLEDB 15 

Microsoft Office   Microsoft Excel® 2010 

 Microsoft Excel 2013 

 Microsoft Excel 2016 

Embedded 
Technologies 

 Visual C++ 2005 SP1 Redistributable Package (x86) 

 Visual C++ 2013 Redistributable Package (x86) 

 MSXML 6.0 Service Pack 2 (Microsoft XML Core 
Services) 

.NET Framework   Microsoft .Net Framework 4.0 

 Microsoft .Net Framework 4.5.0 
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Supported and Compatible Deployment Technology 

 Microsoft .Net Framework 4.5.1 

 Microsoft .Net Framework 4.5.2 

 Microsoft .Net Framework 4.6 

 Microsoft .Net Framework 4.6.1 

NOTE: You can download the Microsoft.NET Framework from 
Microsoft’s Web site at http://www.microsoft.com/en-
us/download/details.aspx?id=17718. For instructions for 
adding it using Server Manager, see your Microsoft Windows 
documentation. 

 

 

The wInsight database must contain at least one contract with more than one period of 
data. 

Server Installation 

Supported and Compatible Deployment Technology 

Web Server  Internet Information Services 7.5 (Compatible)   

 Internet Information Services 8 

 Internet Information Services 8.5 

 QlikView Web Server 11.2 SR15 

NOTE: When installing IIS, make sure to install the IIS 
Management Scripts and Tools, ASP.NET 4.5, and 
Windows Authentication components.  

For information on how to install these components, refer to the 
Microsoft documentation on this link:  

https://docs.microsoft.com/en-us/iis/install/installing-iis-
85/installing-iis-85-on-windows-server-2012-r2 

Citrix  XenApp 6.0 (Windows Server 2008 R2) (Compatible)   

 XenApp 6.5 (Windows Server 2008 R2) (Compatible)   

 XenApp 7.0 (Windows Server 2008 R2) (Compatible)   

 XenApp 7.0 (Windows Server 2012) 

 XenApp 7.0 (Windows Server 2012 R2) 

 XenApp 7.6 (Windows Server 2012 R2) 

 XenApp 7.7 (Windows Server 2012 R2) 

 XenApp 7.8 (Windows Server 2012 R2) 

 XenApp 7.9 (Windows Server 2012 R2) 

Database  Microsoft SQL Server 2008 R2 (Compatible)   

http://www.microsoft.com/en-us/download/details.aspx?id=17718
http://www.microsoft.com/en-us/download/details.aspx?id=17718
https://docs.microsoft.com/en-us/iis/install/installing-iis-85/installing-iis-85-on-windows-server-2012-r2
https://docs.microsoft.com/en-us/iis/install/installing-iis-85/installing-iis-85-on-windows-server-2012-r2
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Supported and Compatible Deployment Technology 

 Microsoft SQL Server 2012 

 Microsoft SQL Server 2014 

 Microsoft SQL Server 2016 

 Microsoft SQL Server Express 

 Microsoft Access 2007 

 Microsoft Access 2010 

 Microsoft Access 2013 

 Microsoft Access 2016 

 Oracle 11.2 

 Oracle 12.1 

 Oracle is also supported in Linux, Unix, and Exadata. 

Database Drivers NOTE: wInsight Analytics Module requires 64-bit database 
drivers.  

 Oracle Provider for OLE DB 

 Oracle Provider for OLE DB 

 Microsoft SQL Server Native Client 

 Microsoft OLE DB Provider for SQL Server 

 Microsoft OLE DB Provider for Jet 

 Microsoft ACE OLEDB 12 

 Microsoft ACE OLEDB 15 

Microsoft Office   Microsoft Excel 2010 

 Microsoft Excel 2013 

 Microsoft Excel 2016 

Browsers  Internet Explorer® 10 

 Internet Explorer 11 

 Microsoft Edge 

 Chrome© 

 Safari® 

 Firefox© 

Embedded Technologies  Visual C++ 2005 SP1 Redistributable Package (x86) 

  

.NET Framework   Microsoft .Net Framework 4.0 

 Microsoft .Net Framework 4.5.0 
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Supported and Compatible Deployment Technology 

 Microsoft .Net Framework 4.5.1 

 Microsoft .Net Framework 4.5.2 

 Microsoft .Net Framework 4.6 

 Microsoft .Net Framework 4.6.1 

NOTE: You can download the Microsoft.NET Framework from 
Microsoft’s web site at http://www.microsoft.com/en-
us/download/details.aspx?id=17718. For instructions for adding 
it using Server Manager, see your Microsoft Windows® 
documentation. 

 

 The wInsight database must contain at least one contract with more than one period of data. 

The 64-bit Access drivers are not compatible with 32-bit versions of MS Office. If are using 
Access on the server, you need to install 64-bit versions of Excel (and other Office products). 

 

http://www.microsoft.com/en-us/download/details.aspx?id=17718
http://www.microsoft.com/en-us/download/details.aspx?id=17718
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Types of Installations 

You can install the wInsight Analytics Module on a server for use by multiple users or on a 
standalone computer for use by a single user. This guide contains instructions and related 
information for both types of installations. 

 For information on how to install the wInsight Analytics Module on a server, see Server 
Installation. 

 For information on how to install the wInsight Analytics Module on a standalone 
computer, see Standalone Installation. 

 You may also upgrade your existing wInsight Analytics Module installation. For more 
information, see Upgrade Installations. 
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Upgrade Installations  

If you are currently using an earlier version of the wInsight Analytics Module and are upgrading to 
8.1.1, read the important notes below before you begin the 8.1.1 installation. 

Preparing Your Existing wInsight Analytics Module Server or 
Standalone Computer for 8.1.1 Installation 

If you are upgrading to 8.1.1 on your existing production wInsight Analytics Module server or 
standalone computer, you must follow the steps below, uninstall the wInsight Analytics Module, 
and then follow the installation steps for a new installation.  

To prepare your existing wInsight Analytics Module server or standalone computer for 
8.1.1 installation, complete the following steps: 

1. Back up your current wInsight Analytics folders. On the server or standalone computer, 
make backup copies of the following wInsight Analytics installation folders and their sub-
folders:  

 Admin 

 Setup 

 Final 

This is crucial if you want to restore your configuration settings following the installation.  

2. Uninstall your existing wInsight Analytics Module.  

If you reinstall wInsight Analytics Module 8.1.1 on top of an existing 8.1.1 installation, the 
installer displays the following message: 

               

3. If you are upgrading from a wInsight Analytics Module version that is earlier than 8.1, 
uninstall QlikView. For more information, see Appendix E: Uninstall QlikView.  

If you start the 8.1.1 installation on a server or standalone computer on which a version of 
wInsight Analytics Module older than 8.1 was installed without first uninstalling QlikView, 
the installer displays the following message: 
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If you want to install 8.1.1 in a different location, you must first uninstall it and then follow the 
installation steps for a new installation. 
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Multiple wInsight Databases 

If your core wInsight Analytics data is divided among multiple databases, Deltek strongly 
recommends that you consolidate those databases into one to take full advantage of the 
capabilities of the wInsight Analytics Module. Existing wInsight functionality is available to 
accomplish the consolidation. Contact Customer Care if you have questions about how to do that. 

A given instance of the wInsight Analytics Module can only be connected to one core wInsight 
database. If you want to retain multiple databases and you want to use the wInsight Analytics 
Module to perform data analysis on the databases, you must set up one instance of the wInsight 
Analytics Module for each core wInsight database. 
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Server Installation 

The information in this section applies only to server installations. If you are doing an installation 
on a standalone computer, see Standalone Installation. 

 

This document assumes that the person installing the wInsight Analytics Module is familiar with 
SQL, Oracle, and Access databases, domain accounts, Windows Authentication, IIS Manager, 
EPM Security Administrator, and wInsight Analytics Administrator. 

For the wInsight Analytics system administrator, additional documentation is available on 

QlikView®, QlikView Server, QlikView Publisher, the QlikView automation interface, and the 
QlikView API. Documentation is located in C:\ProgramData\QlikTech\QlikView Documentation 
and in C:\ProgramData\QlikTech\QlikView Server Documentation on the wInsight Analytics 
Module server or on the standalone computer running the wInsight Analytics Module. 

Preinstallation Checklist 

Steps Related Topics 

1. Make sure all the prerequisites are installed. System Requirements 

2.  Make sure you have all necessary accounts 
set up and you have the serial and control 
numbers for QlikView.  

What You Need to Complete the 
Installation 

3. Make sure that your database setup meets the 
requirements of the wInsight Analytics Module.  

 If you are installing wInsight Analytics 
Module for the first time, Deltek 
recommends that you first test the 
analytics load process using the 
Sample.mdb database file (which is 
included in the installation) before you 
configure it to run against your own 
database. 

 If you choose to load or restore your own 
projects into Sample.mdb to test the load 
process and dashboards, make sure you 
load multiple periods of those projects. 

Multiple wInsight Databases 

4.  Make sure that you have installed wInsight 
Analytics Administrator 8.1.1 and created a 
wInsight Analytics 8.1.1 database. If you have 
an 8.1 or earlier database, you must convert it 
into an 8.1.1 database. 

For information on installing the 
wInsight Analytics Administrator, 
creating an 8.1.1 database, or 
converting an 8.1 or earlier database 
to 8.1.1, see the Setting Up and 
Creating a New Database and 
Conversion Overview sections in the 
Deltek wInsight Analytics Administrator 
8.1.1 Installation Guide. 
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When you open a QVW file and the Module Security for Document dialog box displays, select 
the Allow any Macro (only for trusted documents) option. 

If the Edit Module dialog box displays, make sure that you set the Requested Module Security 
field to System Access and the Current Local Security field to Allow System Access. 

 

Important: It is crucial that you read this entire document as there are a number of important 

steps that you must complete, including steps both before and after the actual installation. You 
will need to log on with the QlikView service account that the setup creates (DeltekAnalytics is 
the default) or that you specify during the installation and perform various tasks outlined below. It 
is very important that you perform these tasks while logged on to the account specified in the 
instructions. 

 The wInsight database must contain at least one contract with more than one period of data. 

The 64-bit Access drivers are not compatible with 32-bit versions of MS Office. If are using 
Access on the server, you need to install 64-bit versions of Excel (and other Office products). 

What You Need to Complete the Installation 

To complete the wInsight Analytics Module server installation, you must have the following: 

 Logon credentials with administrative rights. 

If you need to configure the wInsight Analytics Module further to suit your needs, 
Appendix A: Set Up User Accounts for Loading Data.  

 Service account. 

 Serial number and control number for the QlikView Server. 

 Internet access. 

 QlikView License Enabler File (LEF), if installing on a standalone computer with no 
Internet access. Contact CCOps@deltek.com to get your LEF. If you have someone in 
your company who has Internet access, you may get the LEF from this link: 
http://lef1.qliktech.com/manuallef/default.aspx. 

Your Service Account 

The wInsight Analytics Module requires one service account, which you specify during the 
installation process. The account can be a local account or domain account. If you plan to use 
domain accounts, it is crucial that you read the requirements and recommendations in the next 
section.  

Requirements for Using Domain Accounts as the Service Accounts 

If you are going to use domain accounts, it is very important that you do the following before you 
begin the wInsight Analytics installation: 

 Create the domain accounts in Active Directory, or your LDAP. 

 Set up the account as a member of the local administrators group. Make sure that the 
server is a member of the domain. 

 Make sure you are logged on to that domain, with Administrative rights to the 
server/client, when you install the wInsight Analytics Module. 

mailto:CCOps@deltek.com
http://lef1.qliktech.com/manuallef/default.aspx
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Obtain Your QlikView Serial and Control Numbers 

If you are either a new wInsight Analytics customer or you are upgrading from wInsight Analytics 
6.5.1 or later, and you are installing the wInsight Analytics Module for the first time, contact your 
Deltek Account Manager to get the serial numbers and control numbers that you need for the 
installation. 

Server Installation Procedures 

The installation procedures that follow are for installing the wInsight Analytics Module on a server.  

Step 1: Install the wInsight Analytics Module 

To install the wInsight Analytics Module, complete the following steps: 

1. Log on to the server with an administrator account. 

2. Double-click DeltekwInsightAnalytics811.exe. 

3. On the Welcome page of the Deltek wInsight Analytics Module Installation Wizard, click 
Next.  

4. On the License Agreement page, review the license agreement, select I accept the 
terms of the license agreement, and click Next. 

5. On the Setup Type page, select Server, and click Next. 

6. On the Choose Destination Location page, select folders where you want to install files, 
and click Next. By default, wInsight Analytics Module files are installed in the following 
locations: 

 QlikView Application files — C:\Program Files\QlikView 

 wInsight Application files — C:\Program Files\Deltek\wInsight Analytics 

 wInsight Data files — C:\ProgramData\Deltek\Analytics  

 

You have the option to install the files to a different location by clicking Change.  

The QlikView Application folder contains the Directory Service Connector, Distribution 
Service, Examples, Management Service, QvPlugin, QvProtocol, Server, Support 
Tools, Themes, and Web sub-folders and corresponding files. 

The wInsight Application folder contains the bin and WSWebSvc subfolders and 
corresponding files.  

The wInsight Data folder contains the admin, Database, datapull, extension, final, Logs, 
publish, qvds, setup, Support, and translate sub-folders and corresponding files. 

7. Specify the service account by taking one of the following actions: 

 Specify an existing domain account using the <DOMAIN>\<USER NAME> 
format and corresponding password. 

 Create a local account. 

mailto:CCOps@Deltek.com
mailto:CCOps@Deltek.com
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You have the option to enter a different local account name. It can be an existing 
account or account that does not yet exist. In the latter case, the installation process 
creates the account. 

Instead of using a local account, you can specify an existing domain user name and 
password. 

Before proceeding, make sure you read and complete the prerequisite tasks described 
in Requirements for Using Domain Accounts as the Service Accounts. 

If you are upgrading from an earlier version of wInsight Analytics Module and you have 
not deleted the local account from the previous installation, the following message 
displays: 

 

Click OK. 
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8. On the Add Administrator Users page, select the users who can configure wInsight 
Analytics and run data load, and click Next. By default, the user running the installation 
displays in the list. 

 If you need to add a user, click Add. In the Select User dialog box, enter the domain 
and user name using the <DOMAIN>\<USER NAME> format, and then click OK. 

 

The users that you add on this page are added automatically to the following groups by 
the installation: 

 QlikView Administrators — This group has full access rights to QlikView 

Management Console and authenticates communication between QlikView 
services, if Windows Authentication is used. 

 wInsight Administrator — This group has full access rights to the wInsight 

Analytics Data folder. 

If you still need to add users to these groups after the installation, you can add them 
manually to the Local Users and Groups/Users folder on Windows Computer 
Management. For more information on adding data loading accounts, see Appendix A: 
Set Up User Accounts for Loading Data in this document. 

 If you need to delete a user from the list, click Remove. 

 

When the server where wInsight Analytics Module is being installed has multiple Web 
sites/ports, the Select Web Site page that contains a dropdown list of available Web 
sites will be displayed in the installation wizard and user will be asked to select the Web 
site to be used for his installation. 

9. On the Customer Experience Improvement Program page, if you want to participate in 
the program, leave Send installation data to Deltek selected, and click Next. 

If you participate, the data listed on the page is sent to Deltek automatically during the 
installation process. 

10. On the Start Copying Files page, click Next to start the installation process. The Setup 

Status page displays the status of the process. 

11. When the Installation Complete page displays, click Finish. 

 

By default, the Yes, I want to restart my computer now option is selected. You must 

restart your computer before continuing with the remaining steps in the installation 
process. 

12. After restarting your computer, log on to the server using an Administrator account. 

 

Make sure that the <installation location> folder is not marked as Hidden. Otherwise, 
you might encounter problems in locating the files in the translate folder. 

Step 2: License QlikView Server 

This procedure allows you to license QlikView Server so that you can access wInsight Analytics 
Module from the AccessPoint URL. In addition, this procedure assumes that you are logged on as 
the QlikView administrator account identified during the installation. 

Make sure that all QlikView services are running by clicking Start » Control Panel » 
Administrative Tools » Services and checking the status of the QlikView services. If there is 
any service that does not run automatically after restart, run the service manually by selecting it 
and clicking Start. 
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To license QlikView Server, complete the following steps: 

1. Launch the QlikView Management Console in one of the following ways: 

 Click Start » All Programs » Deltek wInsight Analytics » QlikView Management 
Console. 

Or 

 Run Internet Explorer and go to http://localhost:4780/qmc/default.htm. 

 

If you are asked to log on when you run QlikView Management Console, log on with 
the user name and password for the service account that you entered during the 
installation. 

Select Remember my credentials and click OK. 

2. If you see the following message in the browser window, click the message bar and 
select Enable Intranet Settings: 

“Intranet settings are now turned off by default. Intranet settings are less secure than 
Internet options. Click for options…” 

Click Yes to confirm that you want to turn on intranet security settings. 

3. In the QlikView Management Console, click the System tab, and then click the Licenses 
sub-tab. 

4. Under Type, select QlikView OEM Server. 

  

 

If you are installing wInsight Analytics on a computer with no Internet access, you need a copy 
of your QlikView License Enabler File (LEF). To request your LEF, contact CCOps@deltek.com. 
If you have someone in your company who has Internet access, you may get the LEF from this 
link: http://lef1.qliktech.com/manuallef/default.aspx. 

The administrator account that you associate with the QlikView for Windows (QV.exe) license is 
the only account that can be used to access QlikView for Windows and wInsight Analytics 
Module on this computer. 

http://localhost:4780/qmc/default.htm
mailto:CCOps@deltek.com
http://lef1.qliktech.com/manuallef/default.aspx
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5. Click the QlikView Server License tab in the right pane. 

6. In the Serial number field, enter your QlikView Server serial number.  

7. In the Control field, enter your QlikView Server control number. 

8. In the Name and Organization fields, enter your name and your firm’s name. 

9. Scroll down until the Apply License button is visible, and click Apply License.  

10. A message displays stating that the QlikView Server will be restarted. Click OK.  

If the license information is accepted, information displays in Paste the contents of the 
LEF file here (optional).  

 

To check if the license was applied correctly, click the Status tab in the QlikView 
Management Console, then click Services. The Status column for the Service Name 
should display Running.  If the Status column displays Off Duty, there is a problem 

with the license. 

11. This step is optional and applies only if you have a capped license. Use the directories 
linked to the QlikView server if you need to give other users access to the server. For 
more information, see Appendix B: Add Users to the QlikView Server from a Directory 
(For Capped Licenses). 

12. Still in QlikView Management Console, click the Setup sub-tab on the System tab. 

13. Expand Management Service, and expand QlikView Web Servers. 

14. Select QVWS@servername. 

15. Click the General tab in the right pane. 

16. If the default QlikView Web server port specified in the Port field under Communication 
is already being used for another process, enter another suitable port number. For more 
information, see Appendix C: Change the TCP Port. 

17. Click Apply and proceed to the next step.   

Step 3: Create Tasks for Loading Projects Using QlikView AccessPoint 

To create tasks for loading projects using QlikView AccessPoint, complete the following 
steps: 

1. In QlikView Management Console, click the Documents tab and click User Documents. 

2. Expand QVS@servername. 
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3. Expand the DataPull folder, and then expand the qvs folder. 

  

4. Select wInsight.qvw, and then click the Reload tab in the right pane. 

5. On the Reload tab, mark the On an External Event option, and then click Apply. 

6. Expand the Translate folder and apply the On an External Event option to the following 
QVWs, as well: 

 Data_Model_wInsight.qvw 

 Transform_wInsight.qvw 

 wInsight_Analytics.qvw 

 wInsight_Analytics_MultiProject.qvw 

 wInsight_Metrics.qvw 

7. Click the Status tab and expand ReloadEngine@servername. 

8. Expand the Default folder and confirm that it contains the QVWs that you marked the On 
an External Event option for.   

9. Proceed to the next step. 

Step 4: Clear the Allow Session Recovery Check Box 

1. In QlikView Management Console, click the System tab and the Setup sub-tab. 

2. Expand QlikView Servers and select your QlikView server. 

3. In the right pane, click the Documents tab. 
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4. Make sure that the Allow Session Recovery check box is not marked. 

  

5. Click Apply. 

6. Close the QlikView Management Console.  

Step 5: Launch and License QlikView for Windows  

The following steps assume that you are logged on as the QlikView administrator account 
identified during the installation. 

The procedure you use to license QlikView for Windows depends on the type of license you have. 

 

QlikView for Windows always requires a standalone license key even if it is installed on a server. 
This allows you to access wInsight Analytics Module from the server to perform general 
maintenance, customizations, and data load process. 

If You Have a Capped License 

If you are not sure what type of license you have, contact your Deltek Account Manager.  

To launch and license QlikView for Windows if you have a capped license, complete the 
following steps: 

1. Launch QlikView for Windows. 

2. Click Settings » User Preferences. 

3. On the General tab of the User Preferences dialog box, click Change Interface 
Language. 
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4. On the Select Interface Language dialog box, select English if it is not already selected, 
and click OK. 

 

5. Click OK to close the User Preferences dialog box. 

6. On the QlikView File menu, click Open in Server. 

7. In the Server field, enter qvp://localhost and click Connect. 

The list below the Server field displays localhost. 

  

8. Select wInsight_Analytics.qvw from the bottom list, and click Open. 

9. If the Module Security for Document dialog box displays, select Allow any Macro (only 
for trusted documents), and click OK. Mark the Always use this option for 
documents from this QlikView Server check box to prevent this dialog box from 
displaying in the future.  

10. Close QlikView. If a message displays asking if you want to save changes to 
wInsight_Analytics.qvw, click Yes. 

This process licensed the Client version of QlikView by leasing a license from your server 
installation.  
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If You Have an Uncapped License  

If you have an uncapped license, you have two keys initially, a server license key and a 
standalone license key.  If you are not sure what type of license you have, contact your Deltek 
Account Manager. 

To launch and license QlikView for Windows if you have an uncapped license, complete 
the following steps: 

1. Launch QlikView for Windows. 

2. From the Settings menu, click User Preferences. 

3. In the User Preferences dialog box, click the License tab. 

4. Click the Change button. 

5. Enter your QlikView for Windows standalone license key and control number, and click 
Next. 

6. Read the User License Agreement, and click I Agree.  

7. Take one of the following actions: 

 If you are installing on a computer with an Internet connection, a dialog box displays 
informing you that your license key has been validated. Click Continue in this dialog 
box and proceed to step 8.  

 If you are installing on a computer that does not have an Internet connection, a dialog 
box containing three options displays. Perform the following actions on that dialog 
box: 

a. Select Enter my License Information manually (LEF), and click Continue. 

b. Copy the contents of your License Enabler File (LEF) and paste it into the box 
under Enter your license enabling information. 

c. Click Next. A dialog box displays informing you that your license key has been 
validated. 

d. When the license key has been validated successfully, click Continue. 

8. In the User Preferences dialog box, click OK. 

 

 

After the QlikView for Windows has been licensed, you need to run the 
SetWebServicesURL.bat file, which you can find in the <Installation location>\admin folder, to 

configure the default Web services URL in the wInsight_Analytics.qvw so that you no longer 
need to enter the URL from AccessPoint. 

 

If you are installing wInsight Analytics on a computer with no Internet access, you need a copy 
of your QlikView License Enabler File (LEF). To request your LEF, contact CCOps@deltek.com. 
If you have someone in your company who has Internet access, you may get the LEF from this 

link: http://lef1.qliktech.com/manuallef/default.aspx. 

The administrator account that you associate with the QlikView for Windows license is the only 
account that can be used to access QlikView for Windows and the wInsight Analytics Module on 
this computer. 

 

If Next is grayed out, that means you pasted an invalid LEF. Contact 
CCOps@deltek.com.   

mailto:CCOps@deltek.com
http://lef1.qliktech.com/manuallef/default.aspx
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The remaining installation steps assume that you are logged on as the user who licensed 
QlikView for Windows. This user must also have been identified as wInsight Administrator user 
during the installation. 

Step 6: Configure the Database Connection for wInsight Analytics Module 

 

When you open a QlikView (.QVW) file installed by wInsight Analytics Module, always choose 
the option Allow any Macro (only for trusted documents) when asked. 

To configure the database connection for wInsight Analytics Module, complete the 
following steps: 

1. Launch QlikView for Windows, if it is not already open. 

2. On the File menu, click Open.  

3. In the Open dialog box, browse to the location of the Connection_Setup.qvw file, select 
the file, and click Open. 

By default, Connection_Setup.qvw is saved in C:\ProgramData\Deltek\Analytics\admin\. 
This .qvw file allows you to configure the connection information for QlikView component 
of wInsight Analytics. It also allows you to configure the data source for the wInsight Web 
Services used by the QlikView extension objects by clicking Select wInsight 
Datasource on the wInsight Analytics – Connection Setup tab. 

4. If the Module Security for Document dialog box displays, select Allow any Macro (only 
for trusted documents), and click OK. 

5. On the File menu, click Edit Script, or press CTRL+E.  

6. On the Data tab of the Edit Script dialog box, select OLE DB from the Database drop-
down list, and click Connect. 

7. On the Provider tab of the Data Link Properties dialog box, do one of the following: 

 If your wInsight Analytics database is Microsoft SQL Server, select Microsoft OLE 
DB Provider for SQL Server or SQL Server Native Client, depending on your 
setup, and click Next. 

 

If you use SQL Server Native Client, you must set the Persist Security Info field on 

the All tab of the Data Link Properties dialog box to “True.”  To do this, complete the 
following steps: 

1. While still In the Data Link Properties dialog box, click the All tab. 

2. Scroll down and double-click Persist Security Info. 

3. Select True in the Property Value field of the Edit Property Value dialog box.  

 If your wInsight Analytics database is Oracle, select Oracle Provider for OLE DB, 
and click Next. 

 If your wInsight Analytics database is Access, select Microsoft Office 12.0 Access 
Database Engine OLE DB Provider or Microsoft Office 15.0 Access Database 
Engine OLE DB Provider, and click Next.  

 

After the QlikView for Windows has been licensed, you need to run the 
SetWebServicesURL.bat file, which you can find in the <Installation location>\admin folder, to 

configure the default Web services URL in the wInsight_Analytics.qvw so that you no longer 
need to enter the URL from AccessPoint. 
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 If your OLE DB provider is not listed, install and configure it before proceeding. 

 

The server installation requires 64-bit drivers. 

Deltek recommends SQL Server and Oracle databases for production use. 
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8. On the Connection tab of the Data Link Properties dialog box, do the following: 

Microsoft SQL Server: 

a. In Select or enter a server name, enter your wInsight Analytics database server 
name. 

b. Select Use a specific user name and password, and enter your user name and 
password.  

This was the user name you created when you set up the wInsight database using 
the Deltek wInsight Analytics Administrator.  

c. Select Allow saving password. 

d. In Select the database on the server, select your wInsight Analytics database. 

Oracle: 

a. In Data Source, enter the TNS names ID for the Oracle connection. 

b. Under Use a specific user name and password, enter your user name and 
password. 

This was the user name you created when you set up the wInsight database using 
the Deltek wInsight Analytics Administrator.  

c. Select Allow saving password. 

Microsoft Access: 

a. Enter the location path of the database. For example, 
C:\ProgramData\Deltek\Analytics\data\Sample.mdb. 

b. Enter your user name and password (if applicable). For Access databases, the 
default user name is “Admin” and there is no password required.  

c. Select Allow saving password. 

9. Click Test Connection to check your connections.  

10. If the connection test is successful, click OK. 

11. In the text box on the Main tab, scroll horizontally to the right end of the text area, and 
confirm that something similar to the text shown below displays (it will not be exactly the 
same). Verify that the password in the XPassword statement is encrypted. 

 

If the password is not encrypted, click OK to close the Edit Script dialog box. In the 
main QlikView window, click Settings » User Preferences » General Tab, mark the 
Scramble Connect User Credentials check box, and repeat steps 5 – 9. 
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Microsoft SQL Server 

  

Oracle 
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Access 

 

12. From the File menu, click Export to Script File.  

If the Export to Script File option on the File menu is disabled, copy the entire 
CONNECT TO line (CTRL+C), open <installation 
location>\setup\Connection_wInsight.qvs in Notepad, paste (CTRL+V), and save the file.  

13. In the Save Script dialog box, browse to the location of the Connection_wInsight.qvs 
file, select the file, and click Save. By default, Connection_wInsight.qvw is saved in 
C:\ProgramData\Deltek\Analytics\setup\. 

14. When asked to replace the existing Connection_wInsight.qvs file, click Yes.  

15. Click OK to close the Edit Script dialog box. 

Do not close QlikView as you still need to configure the wInsight data source in the next 
step.  

 

If you are installing wInsight Analytics Module for the first time, Deltek recommends that you first 
test the analytics load process using the Sample.mdb database file (which is included in the 
installation) before you configure it to run against your own database. 

If you choose to load or restore your own projects into Sample.mdb to test the load process and 
dashboards, make sure you load multiple periods of those projects. 

Step 7: Configure the wInsight Web Service Data Source 

To configure the data source used by the wInsight Analytics Web service, complete the 
following steps: 

1. In the main QlikView window, click Select wInsight Datasource.  

2. In the Data Sources dialog box, click Add. 
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3. On the Provider tab of the Data Link Properties dialog box, select the appropriate 
database provider for your database, and click Next. 

 If your wInsight Analytics database is Microsoft SQL Server, select Microsoft OLE 
DB Provider for SQL Server or SQL Server Native Client, depending on your 
setup.  

 

If you use SQL Server Native Client, you must set the Persist Security Info field on the 

All tab of the Data Link Properties dialog box to “True.” To do this, complete the 
following steps: 

1. While still In the Data Link Properties dialog box, click the All tab. 

2. Scroll down and double-click Persist Security Info. 

3. Select True in the Property Value field of the Edit Property Value dialog box.  

 If your wInsight Analytics database is Oracle, select Oracle Provider for OLE DB. 

 If your wInsight Analytics database is Access, select Microsoft Office 12.0 Access 
Database Engine OLE DB Provider or Microsoft Office 15.0 Access Database 
Engine OLE DB Provider. 

4. On the Connection tab, perform the following actions: 

Microsoft SQL Server: 

a. In Select or enter a server name, enter your wInsight Analytics database server 
name. 

b. Select Use a specific user name and password, and enter your user name and 
password.  

This was the user name you created when you set up the wInsight database using 
the Deltek wInsight Analytics Administrator.  

c. Select Allow saving password. 

d. In Select the database on the server, select your wInsight Analytics database. 

Oracle:  

a. In Data Source, enter the TNS names ID for the Oracle connection. 

b. Under Use a specific user name and password, enter your user name and 
password. 

This was the user name you created when you set up the wInsight database using 
the Deltek wInsight Analytics Administrator.  

c. Select Allow saving password. 

Microsoft Access: 

a. Enter the location path of the database. For example, 
C:\ProgramData\Deltek\Analytics\data\Sample.mdb. 

b. Enter your user name and password (if applicable). For Access databases, the 
default user name is “Admin” and there is no password required. 

c. Select Allow saving password. 

5. Click Test Connection to check your connections. 

6. If the connection test is successful, click OK. 

7. In the Edit Data Source dialog box, enter a name for the data source and click OK.  
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8. In the Data Sources dialog box, make sure that the newly added data source is selected, 
and click OK.  

9. Close QlikView.  

10. When asked to save the changes to Connection_Setup.qvw, click Yes. 

 

These steps update both the WSDATA.ini and App.config files with the selected data 
source. 

Step 8: Configure Data Load Settings and Perform Data Load 

Before you perform this task, make sure you copy any customizations that you did from the old 
QVW files (which are located in the <installation location>\Backups folders) into their new 
respective <installation location> folders. 

 

The installation process backs up existing QVW files (under the final, admin, and setup folders) 
prior to installing updated ones. These files are backed up to the <installation location>\Backups 
folder. 

There are two ways to configure data load settings and perform data load: 

 Configure Data Load Settings and Perform Data Load via the QlikView Access Point 

 Configure Data Load Settings via wInsight_Analytics_Config.qvw and Perform Data Load 
Using Batch Files 

Configure Data Load Settings and Perform Data Load via the QlikView 
AccessPoint 

To configure data load settings and perform data load via the QlikView AccessPoint, 
complete the following steps: 

1. Launch QlikView AccessPoint using the shortcut under Deltek wInsight Analytics (not the 
one under QlikView) on the Start menu. You can also launch your browser and enter the 
URL for your QlikView Server Access Point http://<servername>/QlikView/index.htm.  

2. On the QlickView Access Point page, click wInsight_Analytics.qvw. 

3. Click the Project Load tab, if it is not already selected. 

  

 

Before performing this step, make sure you have selected the data source you configured in 
Step 7: Configure the wInsight Web Service Data Source in the Deltek EPM Security 
Administrator. 

If you are upgrading from a previous version of the wInsight Analytics Module, you have the 
option to apply your previous configuration settings. For more information, see Appendix F: 
Apply Previous Configuration Settings. 

Depending on whether or not you will use wInsight Analytics Module security, you must specify 
security options in EPM Security Administrator and in the IIS server. For more information, see 
Appendix G: Specify EPM Security Administrator and IIS Server Security Options. 
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4. In the Web Service URL field, replace [SERVER NAME] with the name of your QlikView 
server host machine and click Connect. 

 

You only need to do this when you launch QlikView AccessPoint for the first time. 

 

 

If you want to test Web services before doing a project load, you need to enter the Web service 
URL on the Project Load tab prior to testing Web services. For more information on testing Web 
services, see the Appendix D: Test Web Services section in this document. 

5. Mark the Load All Projects check box, if it is not already marked.  

6. In the wInsight Database field, select the type of database used to store your wInsight 
data (Access, Oracle, or SQL Server). 

7. Click Update from wInsight Database. The Data Load Status pane displays the 
progress of the configuration update. 

8. When the configuration update is complete, press F5 to refresh the page. 

9. If you have used the Element Type field to identify which elements represent control 
accounts (CAs) and work packages (WPs), the codes you used will be in the Work 
Package Control Account section as element types. You need to mark each element 
type as C if it is a control account or W if it is a work package.  
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For more information about CAs and WPs, see the Configuration section of the wInsight Analytics 
Module 8.1.1 Administration Guide. 

10. Update the information for the following project fields: 

 Current Period 

 Historical Data 

 Forecast Data Load 

 Unit Used as Element of Cost (click  to specify the units that represent Element 

of Cost). 

 

For more information about these fields, see the Configuration section of the wInsight Analytics 
Module 8.1.1 Administration Guide. 

11. Mark the Apply Security if you want to use wInsight Analytics Module security.  

Depending on whether or not you will use wInsight Analytics Module security, you must 
specify security options in EPM Security Administrator and in the IIS server. For more 
information, see Appendix G: Specify EPM Security Administrator and IIS Server Security 
Options. 

12. Mark the WBS OBS Link check box, if it is not already marked. 

 

For more information about the WBS OBS Link, see the Configuration section of the wInsight 
Analytics Module 8.1.1 Administration Guide. 

13. In the No. of Levels of WBS to Support field, specify the number of hierarchical levels 
of the work breakdown structure that you want to include in the data load. Use this field to 
select the amount of detail that is loaded into wInsight Analytics Module if your wInsight 
database is very large. 

14. Leave the Load Metrics check box unmarked.  

15. If this is your first time to load data for all projects, leave the Delete QVDs check box 
unmarked. 
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16. Click Save Settings. If this process is successful, a “Configuration settings have been 

saved…” message displays.  

17. Click Run Data Load. You must perform a full data load before you can run single-
project data loads. If this process is successful, a “Backed up QVWs from \publish 
folder…” message displays. 

Configure Data Load Settings via wInsight_Analytics_Config.qvw and Perform 
Data Load Using Batch Files  

To configure data load settings by manually launching wInsight_Analytics_Config.qvw 
and perform data load using batch files, complete the following steps: 

1. In Windows Explorer, browse to wInsight_Analytics_Config.qvw, and double-click the 
file. By default, wInsight_Analytics_Config.qvw is in 
C:\ProgramData\Deltek\Analytics\admin\. 

2. On the Tools menu, click Edit Module. 

3. If Requested Module Security does not contain System Access in the Edit Module 
dialog box, select that option. 

4. If Current Local Security does not contain Allow System Access in the Edit Module 
dialog box, select that option. 

5. Click OK and save the file. 

6. Under wInsight Database on the wInsight Analytics Configuration tab, select the type of 
database used to store your wInsight data (Access, Oracle, or SQL Server). 

7. Click Update from wInsight Database. The Script Execution Progress dialog box 
displays the progress of the update. 

8. If you have used the Element Type field to identify which elements represent control 
accounts (CAs) and work packages (WPs), the codes you used will be under the 
Element Type column as element types. You need to mark each element type as C if it 
is a control account or W if it is a work package.  

 

9. Update the information for the following project fields: 
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 Current Period 

 Historical Data 

 Forecast Data Load 

 Unit Used as Element of Cost  

 

For more information about these fields, see the Configuration section of the wInsight Analytics 
Module 8.1.1 Administration Guide. 

10. Mark the WBS OBS Link check box, if it is not already marked. 

 

For more information about the WBS OBS Link, see the Configuration section of the wInsight 
Analytics Module 8.1.1 Administration Guide. 

11. In the No. of Levels of WBS to Support field, specify the number of hierarchical levels 
of the work breakdown structure that you want to include in the data load. Use this field to 
select the amount of detail that is loaded into wInsight Analytics Module if your wInsight 
database is very large. 

12. In the Security field, indicate whether or not you want to use wInsight Analytics Module 
security.  

Depending on whether or not you will use wInsight Analytics Module security, you must 
specify security options in EPM Security Administrator and in the IIS server. For more 
information, see Appendix G: Specify EPM Security Administrator and IIS Server Security 
Options. 

13. Click Save Settings for wInsight Analytics. If this process is successful, a 
“Configuration settings have been saved…” message displays. Click OK in the message. 

14. Click Run Data Load Batch File. You must perform a full data load before you can run 

single-project data loads. 

15. When QlikView asks if you approve the application for launch, click Yes. The Script 
Execution Progress dialog box displays the progress of the data load. 
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Server Installation: Technical Notes 

Make the wInsight Analytics Module Server a Trusted Site 

To avoid a variety of problems that can occur due to browser internet/intranet security, all 
wInsight Analytics Module users, regardless of how they access the product, should add the 
wInsight Analytics Module server (http://<server name>) to their list of trusted sites on the 
Security tab of the Internet Options dialog box in Microsoft Internet Explorer.  

Miscellaneous Technical Notes 

The following are miscellaneous technical notes related to the installation of the wInsight 
Analytics Module: 

 If you do not specify a domain account or an existing local account as the QlikView 
service account, the installation creates a local user with the name you specified 
(DeltekAnalytics is the default). It adds that user to the local administrators group and to 
the “Log On as Service” policy. 

 The installation sets registry key – 
HKEY_LOCAL_MACHINE\SOFTWARE\QlikTech\QlikViewServer\Settings 
7\DocumentDirectory = <installation location>\publish. By default, the location is 
C:\ProgramData\Deltek\Analytics\publish. 
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Standalone Installation 

The information in this section applies only to standalone installations. If you are doing an 
installation on a server, see Server Installation. 

 

This document assumes that the person installing the wInsight Analytics Module is familiar with 
SQL, Oracle, and Access databases, domain accounts, Windows Authentication, IIS Manager, 
wInsight Analytics EPM Security Administrator, and wInsight Analytics Administrator. 

For the wInsight Analytics system administrator, additional documentation is available on 

QlikView®, QlikView Server, QlikView Publisher, the QlikView automation interface, and the 
QlikView API. Documentation is located in C:\ProgramData\QlikTech\QlikView Documentation 
and in C:\ProgramData\QlikTech\QlikView Server Documentation on the wInsight Analytics 
Module server or on the standalone computer running the wInsight Analytics Module. 

Preinstallation Checklist 

Steps  Related Topics 

1. Make sure all the prerequisites are installed. System Requirements 

2.  Make sure you have all necessary accounts 
set up and you have the serial and control 
numbers for QlikView.  

What You Need to Complete the 
Installation 

3. Make sure that your database setup meets the 
requirements of the wInsight Analytics Module.  

 If you are installing wInsight Analytics 
Module for the first time, Deltek 
recommends that you first test the 
analytics load process using the 
Sample.mdb database file (which is 
included in the installation) before you 
configure it to run against your own 
database. 

 If you choose to load or restore your own 
projects into Sample.mdb to test the load 
process and dashboards, make sure you 
load multiple periods of those projects. 

Multiple wInsight Databases 

4.  Make sure that you have installed wInsight 
Analytics Administrator 8.1.1 and created a 
wInsight Analytics 8.1.1 database. If you have 
an 8.1 or earlier database, you must convert it 
into an 8.1.1 database. 

For information on installing the 
wInsight Analytics Administrator, 
creating an 8.1.1 database, or 
converting an 8.1 or earlier database 
to 8.1.1, see the Setting Up and 
Creating a New Database and 
Conversion Overview sections in the 
Deltek wInsight Analytics Administrator 
8.1.1 Installation Guide. 
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When you open a QVW file and the Module Security for Document dialog box displays, select 
the Allow any Macro (only for trusted documents) option. 

If the Edit Module dialog box displays, make sure that you set the Requested Module Security 
field to System Access and the Current Local Security field to Allow System Access. 

 

Important: It is crucial that you read this entire document as there are a number of important 

steps that you must complete, including steps both before and after the actual installation. For 
most of the steps, you must be logged on with the user account that you link to the QlikView for 
Windows license. 

What You Need to Complete the Installation 

To complete the wInsight Analytics Module standalone installation, you must have the following: 

 Logon credentials with administrative rights.   

 Serial number and control number for QlikView for Windows. 

 Internet access. 

 QlikView License Enabler File (LEF), if installing on a standalone computer with no 
Internet access. Contact CCOps@deltek.com to get your LEF. If you have someone in 
your company who has Internet access, you may get the LEF from this link: 
http://lef1.qliktech.com/manuallef/default.aspx.  

Obtain Your Serial Number and Control Number for the Installation 

If you are either a new wInsight Analytics customer or you are upgrading from wInsight 6.5.1, and 
you are installing the wInsight Analytics Module for the first time, contact your Deltek Account 
Manager to get the serial number and control number that you need for the installation. 

Standalone Installation Procedures 

The installation procedures that follow are for installing the wInsight Analytics Module on a 
standalone computer. 

Step 1: Install the wInsight Analytics Module 

To install the wInsight Analytics Module for the first time, complete the following steps: 

1. Log on to the standalone computer with an administrator account. 

2. Double-click DeltekwInsightAnalytics811.exe. 

3. On the Welcome page of the Deltek wInsight Analytics Module Installation Wizard, click 
Next.  

4. On the License Agreement page, review the license agreement, select I accept the 
terms of the license agreement, and click Next. 

5. On the Setup Type page, select Stand-Alone, and click Next. 

6. On the Choose Destination Location page, select the folders where you want to install 
files, and click Next. By default, wInsight Analytics Module files are installed in the 
following locations: 

 QlikView Application files — C:\Program Files\QlikView 

 wInsight Data files — C:\Users\<User name>\<Documents>\Deltek\Analytics  

mailto:CCOps@deltek.com
http://lef1.qliktech.com/manuallef/default.aspx


Standalone Installation 

 

Installation Guide (Server and Standalone) 43 

 

 

<Documents> refers to Documents in Windows 8/8.1 and My Documents in Windows 
7. 

If you want to install the files to a different location, click Change. 

7. On the Customer Experience Improvement Program page, if you want to participate in 
the program, leave Send installation data to Deltek selected, and click Next. 

If you participate, the data listed on the page is sent to Deltek automatically during the 
installation process. 

8. On the Start Copying Files page, click Next to start the installation process. 

The Setup Status page displays the status of the process. 

9. When the Installation Complete page displays, click Finish. 

 

By default, the Yes, I want to restart my computer now option is selected. You must 

restart your computer before continuing with the remaining steps in the installation 
process. 

Step 2: Launch and License QlikView for Windows (Standalone Installation) 

This procedure does not apply if you are upgrading from a previous installation of wInsight 
Analytics Module. In this case, the system uses the license key used in the previous installation.  

This procedure requires your QlikView standalone license key and control number, allowing you 
to access wInsight Analytics Module from the server to perform general maintenance, 
customizations, and data load process. 

To launch and license QlikView for Windows, complete the following steps: 

1. Log onto your computer using the administrator user account that you want associated 
with the QlikView for Windows license. 

2. Launch QlikView for Windows. 

3. Click Settings » User Preferences. 

4. On the General tab of the User Preferences dialog box, click Change Interface 

Language. 

 

If you are installing wInsight Analytics on a computer with no Internet access, you also need a 
copy of your QlikView License Enabler File (LEF). To request your LEF,  contact 
CCOps@deltek.com. If you have someone in your company who has Internet access, you may 
get the LEF from this link: http://lef1.qliktech.com/manuallef/default.aspx. 

The administrator account that you associate with the QlikView for Windows license is the only 
account that can be used to access QlikView for Windows and the wInsight Analytics Module on 
this computer. 

mailto:CCOps@deltek.com
http://lef1.qliktech.com/manuallef/default.aspx
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5. On the Select Interface Language dialog box, select English if it is not already selected, 
and click OK. 

 

6. Click the License tab. 

 

7. Click Change. 

8. In the License Key and Control Number fields, enter your QlikView for Windows license 

key and control number. 
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9. In the User Name and Organization fields, enter your name and your firm’s name. 

 

10. Click Next. 

11. Read the QlikView license agreement, and click I Agree. 

12. Take one of the following actions: 

 If you are installing on a computer with an Internet connection, a dialog box displays 
informing you that your license key has been validated. Click Continue in this dialog 
box and proceed to step 13.  

 If you are installing on a computer that does not have an Internet connection, a dialog 
box containing three options displays. Perform the following actions on that dialog 
box: 

a. Select Enter my License Information manually (LEF), and click Continue. 

b. Copy the contents of your License Enabler File (LEF) and paste it into the box 

under Enter your license enabling information. To request your LEF, contact 

CCOps@deltek.com. If you have someone in your company who has Internet 

access, you may get the LEF from this link: 

http://lef1.qliktech.com/manuallef/default.aspx. 

  

mailto:CCOps@deltek.com
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c. Click Next. A dialog box displays informing you that your license key has been 
validated. 

 

d. Click Continue and proceed to the next step. 

13. In the User Preferences dialog box, click OK.  

Step 3: Configure the Database Connection for wInsight Analytics Module 

 

When you open a QlikView (.QVW) file installed by wInsight Analytics Module, always choose 
the option Allow any Macro (only for trusted documents) when asked. 

To configure the database connection for wInsight Analytics Module, complete the 
following steps: 

1. On QlikView’s File menu, click Open.  

2. In the Open dialog box, navigate to your Documents library. 

3. In your Documents library, click Deltek » Analytics » admin, and select the 
Connection_Setup.qvw file.    

 

<Documents> refers to Documents in Windows 8/8.1 and My Documents in Windows 
7. 

4. Click Open. 

5. On the File menu, click Edit Script, or press CTRL+E.  

6. In the Data tab of the Edit Script dialog box, select OLE DB from the Database drop-
down list, and click Connect. 

  

 

If Next is grayed out, that means you pasted an invalid LEF. Contact 
CCOps@deltek.com.   

mailto:CCOps@deltek.com
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7. On the Provider tab of the Data Link Properties dialog box, perform one of the following 
actions: 

 If your wInsight Analytics database is Microsoft SQL Server, select Microsoft OLE 
DB Provider for SQL Server or SQL Server Native Client, depending on your 
setup, and click Next. 

 

If you use SQL Server Native Client, you must set the Persist Security Info field on 

the All tab of the Data Link Properties dialog box to “True.” To do this, complete the 
following steps: 

1. While still In the Data Link Properties dialog box, click the All tab. 

2. Scroll down and double-click Persist Security Info. 

3. Select True in the Property Value field of the Edit Property Value dialog box.  

 If your wInsight Analytics database is Oracle, select Oracle Provider for OLE DB, 
and click Next. 

 If your wInsight Analytics database is Access, select Microsoft Office 12.0 Access 
Database Engine OLE DB Provider or Microsoft Office 15.0 Access Database 
Engine OLE DB Provider, and click Next.  

 If your OLE DB provider is not listed, install and configure it before proceeding. 

8. On the Connection tab of the Data Link Properties dialog box, do the following: 

Microsoft SQL Server: 

a. In Select or enter a server name, enter your wInsight Analytics database server 
name. 

b. Select Use a specific user name and password, and enter your user name and 
password.  

This was the user name you created when you set up the wInsight database using 
the Deltek wInsight Analytics Administrator.  

c. Select Allow saving password. 

d. In Select the database on the server, select your wInsight Analytics database. 

Oracle: 

a. In Data Source, enter the TNS names ID for the Oracle connection. 

b. Under Use a specific user name and password, enter your user name and 
password. 

This was the user name you created when you set up the wInsight database using 
the Deltek wInsight Analytics Administrator.  

c. Select Allow saving password. 

Microsoft Access: 

a. Enter the location path of the database. For example, C:\Program Files 
(86)\Deltek\wInsight Analytics\data\Sample.mdb. 

b. Enter your user name and password (if applicable). For Access databases, the 
default user name is “Admin” and there is no password required. 

c. Select Allow saving password. 

9. Click Test Connection to check your connections. 
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10. If the connection test is successful, click OK. 

11. In the text box on the Main tab, scroll horizontally to the right end of the text area, and 
confirm that something similar to the text shown below displays (it will not be exactly the 
same). If you specified a password, verify that the password in the XPassword statement 
is encrypted. 

 

If the password is not encrypted, click OK to close the Edit Script dialog box. In the 
main QlikView window, click Settings » User Preferences » General Tab, mark the 
Scramble Connect User Credentials check box, and repeat steps 5 – 9 in this 

procedure. 

Microsoft SQL Server 

 

Oracle 
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Access 

 

12. On the File menu, click Export to Script File. 

If the Export to Script File option on the File menu is disabled, copy the entire 
CONNECT TO line (CTRL+C), open the Connection_Setup.qvw file in Notepad 
(Documents » Deltek » Analytics » setup), paste (CTRL+V), and save the file.  

 

<Documents> refers to Documents in Windows 8/8.1 and My Documents in Windows 
7. 

13. In the File name field of the Save Script dialog box, browse to the location of the 
Connection_wInsight.qvw file, select the file, and click Save. By default, 
Connection_wInsight.qvw is saved in C:\Users\<User 
name>\<Documents>\Deltek\Analytics\setup. 

14. When asked to replace the existing file, click Yes.  

15. Click OK to close the Edit Script dialog box. 

16. Close QlikView. When asked to save the changes to Connection_wInsight.qvw, click 
Yes.  

 

If you are installing wInsight Analytics Module for the first time, Deltek recommends that you first 
test the analytics load process using the Sample.mdb database file (which is included in the 
installation) before you configure it to run against your own database. 

If you choose to load or restore your own projects into Sample.mdb to test the load process and 
dashboards, make sure you load multiple periods of those projects. 
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Step 4: Configure Data Load Settings and Perform Data Load 

Though you are not running QlikView for Windows directly, you must be logged on with the user 
name and password associated with your QlikView for Windows standalone license key to run the 
data load process. 

 

If you are upgrading from a previous version of the wInsight Analytics Module, you have the 
option to apply your previous configuration settings. For more information, see Appendix F: 
Apply Previous Configuration Settings. 

Before performing a data load, make sure that the Authentication Mode in EPM Security 
Administrator is set to None.  

If Security is set to Yes in wInsight Analytics Administrator, loading data requires the user to 

have full rights or write access to all contracts in the database.  

For information on how wInsight security is enabled, refer to the Security section of the wInsight 
Analytics Module 8.1.1 Administration Guide and the EPM Security Model for wInsight Analytics 
topic in the wInsight Analytics Administrator 8.1.1 online help. 

To configure data load settings and perform data load, complete the following steps: 

1. Launch QlikView for Windows. 

2. On the File menu, click Open. 

3. In the Open dialog box, navigate to the wInsight_Analytics_Config.qvw file (Documents » 
Deltek » Analytics » admin), select the file, and click Open.  

 

<Documents> refers to Documents in Windows 8/8.1 and My Documents in Windows 
7. 

4. On the Tools menu, click Edit Module. 

5. If Requested Module Security does not contain System Access in the Edit Module 
dialog box, select that option. 

6. If Current Local Security does not contain Allow System Access in the Edit Module 
dialog box, select that option. 

7. Click OK and save the file. 
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8. Under wInsight Database on the wInsight Analytics Configuration tab, select the type of 
database used to store your wInsight data (Access, Oracle, or SQL Server). 

9. Click Update from wInsight Database. The Script Execution Progress dialog box 
displays the progress of the update. 

10. If you have used the Element Type field to identify which elements represent control 
accounts (CAs) and work packages (WPs), the codes you used will be under the 
Element Type column as element types. You need to mark each element type as C if it 
is a control account or W if it is a work package. 

 

11. Update the information for the following project fields: 

 Current Period 

 Historical Data 

 Forecast Data Load 

 Unit Used as Element of Cost  

 

For more information about these fields, see the Configuration section of the wInsight Analytics 
Module 8.1.1 Administration Guide. 

12. Mark the WBS OBS Link check box, if it is not already marked. 

 

For more information about the WBS OBS Link, see the Configuration section of the wInsight 
Analytics Module 8.1.1 Administration Guide. 

13. In the No. of Levels of WBS to Support field, specify the number of hierarchical levels 
of the work breakdown structure that you want to include in the data load. Use this field to 
select the amount of detail that is loaded into wInsight Analytics Module if your wInsight 
database is very large. 

  



Standalone Installation 

 

Installation Guide (Server and Standalone) 52 

 

14. In the Security field, indicate whether or not you want to use wInsight Analytics Module. 

 

If you enabled wInsight Analytics Module security, you must set the Authentication Mode to 
Windows in EPM Security Administrator.  

If you disabled wInsight Analytics Module security, you must set the Authentication Mode to 
None in EPM Security Administrator.  

For more information, see the EPM Security Administrator online help.  

15. Click Save Settings for wInsight Analytics. If this process is successful, a 
“Configuration settings have been saved…” message displays. Click OK in the message. 

16. Click Run Data Load Batch File to start the data load. The Script Execution Progress 
dialog box displays the progress of the data load. When the processes are completed, 
the command window closes. 

You have the option to run the Load_wInsight_Data.bat file manually. In Windows 
Explorer, go to Documents » Deltek » Analytics » admin and double-click the 
Load_wInsight_Data.bat file. This batch file runs a number of processes in a command 
window. 
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Appendix A: Set Up User Accounts for Loading 
Data 

The user performing the data load must be a member of the SYSADMIN group. Below are some 
of the requirements for this user: 

 The user must have Administrator access to the server hosting the wInsight Analytics 
Module. 

 This applies to server installations only . The user must be a member of the QlikView 
Administrator and wInsight Administrator groups.  

 To perform data loading from a Standalone PC or a Server, the user needs a licensed 
QlikView for Windows account. 

 This applies to server installations only. To perform data loading from the AccessPoint, 
the user needs a license in the QlikView Management Console. 

 

In the event that data load will be performed by a user who is not a member of the SYSADMIN 
group and wInsight security is enabled, that user must have access to at least one contract in 
the database. That user must also have a role in the Deltek EPM Security Administrator that 
allows him/her to perform project loads. 

The installer automatically creates wInsight Analytics Administrator and QlikView Administrator 
groups that have full control rights to wInsight Data and QlikView folders. The next steps should 
only be done if you need to add new user who will perform data loads and that user was not 
added during the installation of the wInsight Analytics Module. 

Step 1: Add a new user account to wInsight Analytics Module 

The System Administrator can add a new user who will be responsible for loading data to the 
wInsight Analytics Module.  

To add a new user account to wInsight Analytics Module, complete the following steps:  

1. Click Start » Control Panel » Administrative Tools » Computer Management. 

2. On the Computer Management screen, click Local Users and Groups » Groups. 

3. Add the user to the following groups:  

 QlikView Administrators  

 wInsight Administrator  

Make sure the From this location field in the Select Users, Computers, Service 
Accounts, or Groups dialog box is for the domain or local machine, depending on which 
user(s) you are adding. Click Locations to change between domain and local machine 
names. 

 

Adding the user to these groups gives full control permission to the following files: 

 QlikView Application files — C:\Program Files\QlikView 

 wInsight Application files — C:\Program Files\Deltek\wInsight Analytics 

 wInsight Data files — C:\ProgramData\Deltek\Analytics 
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Step 2: Add the new wInsight Analytics user to EPM Security Administrator 

Any wInsight Analytics user who will access QlikView AccessPoint must be added to the EPM 
Security Administrator, regardless of whether that user will perform data loads or not. Deltek 
recommends that the user performing data loads be added to the SYSADMIN group in EPM 
Security Administrator. 

 

For information, see Appendix B: EPM Security Administrator of the wInsight Analytics section of 
the wInsight Analytics Administrator 8.1.1 Installation Guide. 

 

 

For additional information on loading data from the wInsight database to the wInsight Analytics 
Module see the Configuration and Data Load chapters of the Deltek wInsight Analytics Module 
8.1.1 Administration Guide. 
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Appendix B: Add Users to the QlikView Server 
from a Directory (For Capped Licenses) 

By linking QlikView to a directory, you can easily add users to the QlikView Server for capped 
licenses, which allow them to access wInsight Analytics Module from the AccessPoint URL. 

Link a Directory to the QlikView Server 

To link a Directory to the QlikView Server, complete the following steps: 

1. Launch the QlikView Management Console in one of the following ways: 

 Click Start » All Programs » Deltek wInsight Analytics » QlikView Management 
Console. 

Or 

 Run Internet Explorer and go to http://localhost:4780/qmc/default.htm. 

 

If you are asked to log on when you run QlikView Management Console, log on with 
the user name and password for the service account that you entered during the 
installation. 

Select Remember my credentials and click OK. 

2. If you see the following message in the browser window, click the message bar and 
select Enable Intranet Settings: 

“Intranet settings are now turned off by default. Intranet settings are less secure than 
Internet options. Click for options…” 

Click Yes to confirm that you want to turn on intranet security settings. 

3. In the QlikView Management Console, click the System tab, and then click the Setup 
sub-tab. 

4. Expand the Directory Service Connectors folder. 

5. Expand DSC@machinename and select a directory type. 

    

6. In the right pane, click . 

http://localhost:4780/qmc/default.htm
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7. Configure the following text boxes: 

 Path – Enter the LDAP path to the directory service. You may also click  (Get 
Default) to get the default LDAP path. The default path corresponds to the domain of 
the account that you used in installing wInsight Analytics Module.  

For more information, see Requirements for Using Domain Accounts as the Service 
Accounts.    

 User Name – Enter the user name for the account used to access the directory 
service using this format: <DOMAIN>\<USER NAME>. 

 Password – Enter the password for the account used to access the directory service. 

8. Click Apply. 

Add Users from a Directory to the QlikView Server 

To add users from a Directory to the QlikView Server, complete the following steps: 

1. In the QlikView Management Console, click the System tab, and then click the Licenses 
sub-tab. 

2. Under Type, select QlikView OEM Server. 

3. Click the Client Access Licenses (CALs) tab in the right pane, and click the Assigned 
CALs sub-tab. 

 

4. Click  (Manage Users). 

5. In the Manage Users dialog box, use the Default Scope field to select the directory that 
you want to use. You may select any of the directories that you linked to the QlikView 
Server using the procedure in Link an Active Directory to the QlikView Server).  

You may also use the default value (All Directories) to display all directories linked to 
the QlikView Server.  



Appendix B: Add Users to the QlikView Server from a Directory (For Capped Licenses) 

 

Installation Guide (Server and Standalone) 57 

 

6. In the Search for Users and Groups field, enter the name of the user that you want to 
add to the QlikView Server followed by an asterisk. For example: johndoe*. 

 

For more information about the supported search criteria for adding user names to the 
QlikView Server using directories, see the “Search Functions” topic in the QlikView 
Management Console online help. 

7. Click . The Search Result column is populated by user names that matched your 
search criteria. 

8. Select the users that you want to add to the QlikView Server and click Add.  

You may select multiple users simultaneously by using Shift + Left Click or Ctrl + Left 
Click.  

For user names that do not exist in the selected directory, use the Manual Input of User 
Names field. 

9. After adding users to the Selected Users column, click OK. 

10. On the Assigned CALs sub-tab, click Apply. 
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Appendix C: Change the TCP Port 

Perform this step only if you do need to change the TCP Port used by the QlikView Web Server 
Service.  

To change the port number, complete the following steps: 

1. Go to the <installation location>\Server\Web Server folder. By default, the Server\Web 
Server folder is in C:\Program Files\QlikView\. 

2. Back up QVWebServer.exe.config. 

3. Open QVWebServer.exe.config in a Text editor and change the port value to the 
desired port as shown below in the value= area. 

"<!-- The port the service listens to. --> 

<add key="WebservicePort" value="4750"/>" 

4. Save the file 

5. Restart the Web Server Service (QlikView Web Server) or the Settings Service (IIS Web 
server) 

6. Open the QlikView Management Console. 

7. Click System » Setup » QlikView Web Servers. 

8. Click the Edit button. 

9. Change the default TCP port of 4750 to the port specified in step 3 (for example, 
http://<servername>:4750/QVWS/Service). 

10. Click Apply. 

11. Click Status » Services to verify the QVWS resource is online. 
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Appendix D: Test Web Services 

Use the Test Web Services feature if you encounter errors related to object extensions. 

 

If you want to test Web services before doing a project load, you need to enter the Web service 
URL on the Project Load tab prior to testing Web services. For more information, see the Step 8: 
Configure Data Load Settings and Perform Data Load section in this document. 

To test Web Services, complete the following steps: 

1. Launch your browser and enter the URL for your QlikView Server Access Point: 

http://servername/QlikView/index.htm.  

2. Open wInsight_Analytics.qvw. 

  

3. Click the Web Services Test tab, and click Test Web Services. The page displays 
information on whether you were able to log into the QlikView Web Service or not.   

 

 

http://servername/QlikView/index.htm
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Appendix E: Uninstall QlikView 

Use the procedure in this section only if you are upgrading from a wInsight Analytics Module 
version that is earlier than 8.1. If you are upgrading from version 8.1 to 8.1.1, you do not need to 
uninstall QlikView.  

To uninstall QlikView and prepare for the new installation, complete the following steps: 

For wInsight Analytics Module 7.0/7.0.1/8.0/8.0.1 users who are upgrading to 8.1.1: 

1. In Windows Control Panel, uninstall any of the following that appear in your list of 
installed programs: 

 QlikView x64 

 QlikView Server x64 (server installations only) 

 QlikView Plugin (server installations with cache warming implemented only) 

2. In Windows Explorer, delete the following folders: 

 C:\Program Files\QlikView 

 C:\ProgramData\QlikTech 

3. This step applies to server installations only. In Computer Management, navigate to the 
Local Users and Groups/Users folder and delete the user DeltekAnalytics. 

4. This step applies to server installations only. Still in Computer Management, navigate to 
the Local Users and Groups/Groups folder, double-click the QlikView Administrators 
group, and remove the DeltekAnalytics user. 

5. In Task Scheduler, delete all jobs that begin with DeltekwInsightAnalytics. There could 
be up to three of those jobs. 

6. Restart the server or standalone computer. 
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Appendix F: Apply Previous Configuration 
Settings 

The information in this section applies only if you are upgrading from a previous version of the 
wInsight Analytics Module and you want to use your previous configuration settings in the new 
version. 

 

The installation process backs up existing QVW files (under the final, admin, and setup folders) 
prior to installing updated ones. These files are backed up to the <installation location>\Backups 
folder. If you have customized the dashboards, you can access your changes by opening the 
backup files in the folder indicated above and then copying the changes to the new QVW files. 

To upgrade from a previous version of the wInsight Analytics Module and apply your 
previous configuration settings, complete the following steps:  

 

If you have extended the wInsight Analytics Module by modifying the standard analytics or data 
models, you may also need to reapply those changes. 

1. From the backup you made of your wInsight Analytics Module installation folder and 
subfolders, copy the connection_wInsight.qvs from the <backup location>\setup folder 
into the <new installation location>\setup folder. 

2. If wInsight_Analytics_Config.qvw has been updated and you want to apply the previous 
wInsight Analytics Module configuration settings to the new version, do the following: 

a. Double-click the newly installed copy of wInsight_Analytics_Config.qvw. 

b. Click Update from wInsight Database. 

c. From your backup, go to the <backup location>\admin folder and run the old 
version of wInsight_Analytics_Config.qvw to display your previous configuration 
settings. 

d. Duplicate those settings in the new version of wInsight_Analytics_Config.qvw. 

e. Click Save Settings for wInsight Analytics. 

f. On the QlikView toolbar, click  to save your configuration. 
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Appendix G: Specify EPM Security Administrator 
and IIS Server Security Options 

If you will use wInsight Analytics security, you must perform the following: 

 In EPM Security Administrator, set the Authentication Mode to Windows: For more 
information, see the EPM Security Administrator online help.  

 In the IIS server under the WSWebSvc web site, enable Windows Authentication and 
disable Anonymous Authentication. For more information, see the Microsoft Internet 
Information Services (IIS) documentation 
(https://www.iis.net/configreference/system.webserver/security/authentication/windowsau
thentication). 

If you will not use wInsight Analytics security, you must perform the following: 

 In EPM Security Administrator, set the Authentication Mode to None. For more 
information, see the EPM Security Administrator online help.  

 In the IIS server under the WSWebSvc web site, enable Anonymous Authentication. 
For more information, see the Microsoft Internet Information Services (IIS) documentation 
(https://www.iis.net/configreference/system.webserver/security/authentication/windowsau
thentication). 

https://www.iis.net/configreference/system.webserver/security/authentication/windowsauthentication
https://www.iis.net/configreference/system.webserver/security/authentication/windowsauthentication
https://www.iis.net/configreference/system.webserver/security/authentication/windowsauthentication
https://www.iis.net/configreference/system.webserver/security/authentication/windowsauthentication
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Appendix H: If You Need Assistance 

If you need assistance installing, implementing, or using the Deltek wInsight® Analytics Module, 
Deltek makes a wealth of information and expertise readily available to you. 

Customer Services 

For over 30 years, Deltek has maintained close relationships with client firms, helping with their 
problems, listening to their needs, and getting to know their individual business environments. A 
full range of customer services has grown out of this close contact, including the following: 

 Extensive self-support options through the Customer Care Connect Web portal. 

 Phone and email support from Customer Care analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and Web-based training 

 

Find out more about these and other services from the Customer Care Connect site. 

Customer Care Connect Site 

The Deltek Customer Care Connect site is a support Web portal for Deltek customers who 
purchase an Ongoing Support Plan (OSP).  

The following are some of the many options you have at the Customer Care Connect site: 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers 
through the Deltek Connect Customer Forums 

 Display or download product information, such as release notes, user guides, technical 
information, and white papers 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Use Quick Chat to submit a question to a Customer Care analyst online 

 Subscribe to Deltek communications about your Deltek products and services 

 Receive alerts of new Deltek releases and cumulative updates 

 

If you need assistance using the Customer Care Connect site, the online help available on the 
site provides answers for most questions. 



Appendix H: If You Need Assistance 

 

Installation Guide (Server and Standalone) 64 

 

Access Customer Care Connect 

To access the Customer Care Connect site, complete the following steps:  

1. Go to http://support.deltek.com.  

2. Enter your Customer Care Connect User name and Password. 

3. Click Log In. 

 

If you do not have a user name and password for the Customer Care Connect site, contact your 

firm’s wInsight Analytics Administrator. 

If you forget your user name or password, you can click the Account Assistance button on the 

login screen for help. 

Additional Documentation 

The following table lists the additional Deltek documentation available for the wInsight Analytics 
Module. Except where noted, all the user guides and quick reference guides listed in this table 
are available for download from the Deltek Customer Care Connect site. 

Document Name Description 

Deltek wInsight Analytics 8.1.1 Administration 
Guide for the wInsight Analytics Module 

This guide describes how to configure the 
wInsight Analytics Module, how to set up 
security, and how to import data. 

Deltek wInsight Analytics 8.1.1 Product 
Overview 

This document provides a high-level 
overview of the product together with some 
guidance as to which modules should be 
installed to meet the needs of individual 
users. Most users would not need access to 
all modules. 

Deltek wInsight Analytics 8.1.1 Release 
Notes for the wInsight Analytics Module 

This document contains a summary of the 
technical considerations, new features, and 
enhancements of the application. 

 

 

http://support.deltek.com/


 

 

 

Deltek is the leading global provider of enterprise software and information solutions for professional 
services firms, government contractors, and government agencies. For decades, we have delivered 
actionable insight that empowers our customers to unlock their business potential. Over 14,000 
organizations and 1.8 million users in approximately 80 countries around the world rely on Deltek to 
research and identify opportunities, win new business, optimize resource, streamline operations, and deliver 
more profitable projects. Deltek – Know more. Do more.®  

deltek.com 
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